
PROFINET – SD6
Operating manual

en-US
07/2021 
ID 442710.04



Table of contents STOBER

2

07
/2

02
1 

| 
ID

 4
42

71
0.

04

Table of contents

1 Foreword ..................................................................................................................................................................  5

2 User information .......................................................................................................................................................  6

2.1 Storage and transfer ................................................................................................................................................  6

2.2 Described product....................................................................................................................................................  6

2.3 Timeliness ................................................................................................................................................................  6

2.4 Original language .....................................................................................................................................................  6

2.5 Limitation of liability ................................................................................................................................................  6

2.6 Formatting conventions...........................................................................................................................................  6

2.6.1 Display of safety instructions..................................................................................................................  7

2.6.2 Markup of text elements ........................................................................................................................  8

2.6.3 Mathematics and formulas.....................................................................................................................  8

2.7 Trademarks ..............................................................................................................................................................  9

2.8 Explanation of terms................................................................................................................................................  9

3 General safety instructions......................................................................................................................................  10

3.1 Directives and standards........................................................................................................................................  10

3.2 Qualified personnel................................................................................................................................................  10

3.3 Intended use ..........................................................................................................................................................  11

3.4 Operational environment and operation...............................................................................................................  12

3.5 Disposal..................................................................................................................................................................  12

4 Network structure ...................................................................................................................................................  13

5 PN6 communication module ...................................................................................................................................  14

5.1 Installation .............................................................................................................................................................  14

6 Connection..............................................................................................................................................................  15

6.1 Selecting suitable lines...........................................................................................................................................  15

6.2 X200, X201: Fieldbus connection ...........................................................................................................................  15

7 What you should know before commissioning ........................................................................................................  16

7.1 Program interfaces.................................................................................................................................................  16

7.1.1 DS6 program interface..........................................................................................................................  16

7.1.2 TIA Portal program interface ................................................................................................................  19



STOBER Table of contents
07

/2
02

1 
| 

ID
 4

42
71

0.
04

3

7.2 Meaning of parameters .........................................................................................................................................  21

7.2.1 Parameter groups .................................................................................................................................  21

7.2.2 Parameter types and data types...........................................................................................................  22

7.2.3 Parameter types ...................................................................................................................................  23

7.2.4 Parameter structure .............................................................................................................................  23

7.2.5 Parameter visibility ...............................................................................................................................  24

7.3 Signal sources and process data mapping .............................................................................................................  25

7.4 Power-loss protected storage................................................................................................................................  25

8 Commissioning ........................................................................................................................................................  26

8.1 DS6: Configuring the drive controller ....................................................................................................................  27

8.1.1 Initiating the project .............................................................................................................................  28

8.1.2 Parameterizing general PROFINET settings ..........................................................................................  30

8.1.3 Configuring PZD transmission...............................................................................................................  31

8.1.4 Mapping the mechanical axis model ....................................................................................................  33

8.1.5 Transmitting and saving the configuration ...........................................................................................  37

8.1.6 Activating the control panel and testing the configuration..................................................................  39

8.2 TIA Portal: Setting up a PROFINET network ...........................................................................................................  40

8.2.1 Installing the GSD file............................................................................................................................  40

8.2.2 Projecting the PROFINET network ........................................................................................................  41

8.2.3 Configuring the controller ....................................................................................................................  42

8.2.4 Configuring the drive controller ...........................................................................................................  43

8.2.5 Transmitting the configuration.............................................................................................................  46

8.2.6 Testing communication ........................................................................................................................  47

9 Monitoring and diagnostics .....................................................................................................................................  48

9.1 Connection monitoring ..........................................................................................................................................  48

9.2 LED display .............................................................................................................................................................  49

9.2.1 PROFINET state .....................................................................................................................................  49

9.2.2 PROFINET network connection.............................................................................................................  50

9.3 Events.....................................................................................................................................................................  51

9.3.1 Event 52: Communication.....................................................................................................................  52

9.4 Parameters.............................................................................................................................................................  53

9.4.1 A270 | X20x state | G6 | V0 .................................................................................................................  53

9.4.2 A271 | PN state | G6 | V0.....................................................................................................................  53

9.4.3 A272 | PN module/submodule | G6 | V1.............................................................................................  53

9.4.4 A273 | PN device name | G6 | V0 ........................................................................................................  54

9.4.5 A274 | PN IP address | G6 | V0 ............................................................................................................  54

9.4.6 A275 | PN subnet mask | G6 | V0 ........................................................................................................  54

9.4.7 A276 | PN gateway | G6 | V0 ...............................................................................................................  54

9.4.8 A279 | PN MAC addresses | G6 | V0....................................................................................................  54



Table of contents STOBER

4

07
/2

02
1 

| 
ID

 4
42

71
0.

04

10 More on PROFINET? ................................................................................................................................................  55

10.1 PROFINET ...............................................................................................................................................................  55

10.2 Device classes ........................................................................................................................................................  55

10.3 Communication......................................................................................................................................................  56

10.3.1 Cyclical communication: Process data..................................................................................................  56

10.3.2 Acyclical communication: Parameter channel data..............................................................................  56

10.3.3 Programming acyclical communication services ..................................................................................  60

10.4 Communication protocols......................................................................................................................................  61

10.5 Ethernet network addressing.................................................................................................................................  62

10.5.1 MAC address.........................................................................................................................................  62

10.5.2 IP address..............................................................................................................................................  62

10.5.3 Subnet mask .........................................................................................................................................  62

10.5.4 Subnets and gateways ..........................................................................................................................  63

10.5.5 MAC and IP addressing using device names.........................................................................................  63

10.6 Cycle times .............................................................................................................................................................  63

11 Appendix.................................................................................................................................................................  64

11.1 Standard mapping of PROFINET and Drive Based..................................................................................................  64

11.1.1 SD6: RxPZD............................................................................................................................................  64

11.1.2 SD6: TxPZD............................................................................................................................................  65

11.2 Addressing parameters for RECORD record...........................................................................................................  65

11.2.1 Determining the Axis_number..............................................................................................................  65

11.2.2 Calculating the Parameter_number .....................................................................................................  66

11.2.3 Determining the subindex ....................................................................................................................  66

11.3 RDREC, WRREC: RECORD .......................................................................................................................................  67

11.3.1 WRREC: RECORD request: Header structure ........................................................................................  67

11.3.2 RDREC: RECORD response: Header structure .......................................................................................  68

11.3.3 RDREC, WRREC: Error codes .................................................................................................................  69

11.3.4 Attribute and format elements: Possible combinations.......................................................................  70

11.4 Process data modules ............................................................................................................................................  71

11.5 Detailed information..............................................................................................................................................  72

11.6 Abbreviations.........................................................................................................................................................  73

12 Contact....................................................................................................................................................................  74

12.1 Consultation, service and address .........................................................................................................................  74

12.2 Your opinion is important to us .............................................................................................................................  74

12.3 Close to customers around the world....................................................................................................................  75

Glossary ..................................................................................................................................................................  76

List of figures...........................................................................................................................................................  78

List of tables ............................................................................................................................................................  79



STOBER 1 | Foreword
07

/2
02

1 
| 

ID
 4

42
71

0.
04

5

1 Foreword
PROFINET, an open industrial Ethernet standard, is especially well-suited for applications that require fast communication
with a high data rate combined with industrial IT functions. PROFINET is real-time capable and uses IT standards like TCP/IP.

STOBER 6th generation drive controllers support PROFINET, a development of the successful PROFIBUS standard. The drive
controllers are tailored for real-time communication of I/O data and offer the ability to transfer all required data,
parameters and IT functions at the same time.

For drive controllers of the SD6 series, the fieldbus functionality is provided via the PN6 communication module.
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2 User information
This documentation supports you in installing and connecting the PN6 communication module in order to connect a drive
controller of the SD6 series (IO device) in combination with a controller (IO controller) using a PROFINET network.

Technical knowledge

Operating your PROFINET network requires having familiarity with PROFINET network technology and the basics of the
associated Siemens SIMATIC automation systems.

Technical requirements

Before you begin operating your PROFINET network, you need to wire the drive controllers and initially check that they are
functioning correctly. To do so, follow the instructions in the manual for the SD6 drive controller.

2.1 Storage and transfer
As this documentation contains important information for handling the product safely and efficiently, it must be stored in
the immediate vicinity of the product until product disposal and be accessible to qualified personnel at all times.

Also pass on this documentation if the product is transferred or sold to a third party.

2.2 Described product
This documentation is binding for:

SD6 series drive controller in conjunction with the DriveControlSuite software (DS6) in V 6.5-D or higher and associated
firmware in V 6.5-D or higher.

2.3 Timeliness
Check whether this document is the latest version of the documentation. We make the latest document versions for our
products available for download on our website:
http://www.stoeber.de/en/downloads/.

2.4 Original language
The original language of this documentation is German; all other language versions are derived from the original language.

2.5 Limitation of liability
This documentation was created taking into account the applicable standards and regulations as well as the current state of
technology.

No warranty or liability claims for damage shall result from failure to comply with the documentation or from use that
deviates from the intended use of the product. This is especially true for damage caused by individual technical
modifications to the product or the project configuration and operation of the product by unqualified personnel.

2.6 Formatting conventions
Orientation guides in the form of signal words, symbols and special text markups are used to emphasize specific
information so that you are able identify it in this documentation quickly.

http://www.stoeber.de/en/downloads/
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2.6.1 Display of safety instructions
Safety instructions are identified with the following symbols. They indicate special risks when handling the product and are
accompanied by relevant signal words that express the extent of the risk. Furthermore, useful tips and recommendations
for efficient, error-free operation are specially highlighted.

ATTENTION!

Attention

This indicates that damage to property may occur

▪ if the stated precautionary measures are not taken.

CAUTION!

Caution

This word with a warning triangle indicates that minor personal injury may occur

▪ if the stated precautionary measures are not taken.

WARNING!

Warning

This word with a warning triangle means there may be a considerable risk of fatal injury

▪ if the stated precautionary measures are not taken.

DANGER!

Danger

This word with a warning triangle indicates that there is a considerable risk of fatal injury

▪ if the stated precautionary measures are not taken.

Information

Information indicates important information about the product or serves to emphasize a section in the documentation that
deserves special attention from the reader.
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2.6.2 Markup of text elements
Certain elements of the continuous text are distinguished as follows.

Important information Words or expressions with a special meaning

Interpolated position mode Optional: File or product name or other name

Detailed information Internal cross-reference

http://www.samplelink.com External cross-reference

Software and other displays

The following formatting is used to identify the various information content of elements referenced by the software
interface or a drive controller display, as well as any user entries.

Main menu 
Settings

Window names, dialog box names, page names or buttons, combined
proper nouns, functions referenced by the interface

Select 
Referencing method A

Predefined entry

Save your 
<own IP address>

User-defined entry

EVENT 52: 
COMMUNICATION

Displays (status, messages, warnings, faults)

Keyboard shortcuts and command sequences or paths are represented as follows.

[Ctrl], [Ctrl] + [S] Key, shortcut

Table > Insert table Navigation to menus/submenus (path specification)

2.6.3 Mathematics and formulas
The following signs are used to represent mathematical relationships and formulas.

- Subtraction

+ Addition

× Multiplication

÷ Division

| | Amount

http://www.stoeber.de
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2.7 Trademarks
The following names used in connection with the device, its optional equipment and its accessories are trademarks or
registered trademarks of other companies:

Windows®,
Windows® 7,
Windows® 10

Windows®, das Windows®-Logo, Windows® XP, Windows® 7 und Windows® 10 are
registered trademarks of Microsoft Corporation in the United States and/or other
countries.

PROFIBUS®, 
PROFINET®

PROFIBUS® and PROFINET® are registered trademarks of PROFIBUS
Nutzerorganisation e.V., Karlsruhe, Germany.

SIMATIC®, 
TIA Portal®

SIMATIC® and TIA Portal® are registered trademarks of Siemens AG, Munich,
Germany.

All other trademarks not listed here are the property of their respective owners.

Products that are registered as trademarks are not specially indicated in this documentation. Existing property rights
(patents, trademarks, protection of utility models) are to be observed.

2.8 Explanation of terms
As relevant standards and products of other manufacturers are referenced, different manufacturer- or standard-specific
names are used for the same term in this documentation.

For improved understandability, the names in this documentation are standardized to STOBER-specific terminology to the
greatest extent possible. The correlation of STOBER-specific names to other sources can be found in the following table.

STOBER PROFINET

Controller IO controller

Drive controller IO device

Tab. 1: Correlation of STOBER terminology to PROFINET
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3 General safety instructions
There are risks associated with the product described in this documentation that can be prevented by complying with the
described warning and safety instructions as well as the included technical rules and regulations.

3.1 Directives and standards
The European directives and standards relevant for the product specified in this documentation can be taken from the
directives and standards of the corresponding drive controller.

3.2 Qualified personnel
In order to be able to perform the tasks described in this documentation, the persons instructed to perform them must
have the appropriate professional qualification and be able to assess the risks and residual hazards when handling the
products. For this reason, all work on the products as well as their operation and disposal may be performed only by
professionally qualified personnel.

Qualified personnel are persons who have acquired the authorization to perform these activities either through training to
become a specialist and/or instruction by specialists.

Furthermore, valid regulations, legal requirements, applicable basic rules, this documentation and the safety instructions
included in it must be carefully read, understood and observed.
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3.3 Intended use
As defined by EN 50178, SD6 drive controllers are electrical devices operating as power electronics to control the flow of
energy in high-voltage systems.

They are intended solely for the operation of motors that meet the requirements of EN 60034-1:

§ Synchronous servo motors (e.g. of the EZ series)

§ Asynchronous motors

§ Linear motors

§ Torque motors

The connection of other electronic loads or operation outside applicable technical specifications constitutes improper use.

When installing drive controllers in machines, commissioning (i.e. commencing intended operation) may not be performed
until it has been determined that the machine is in compliance with local laws and directives. For example, in the European
region, the following applies:

§ Machinery Directive 2006/42/EC

§ Low Voltage Directive 2014/35/EU

§ EMC Directive 2014/30/EU

EMC-compliant installation

The SD6 drive controller and accessories must be installed and wired compliant for EMC

Modification

As the user, you may not make any physical, technical or electrical modifications to the SD6 drive controller and the
accessories.

Maintenance

The SD6 drive controller and accessories are maintenance-free. However, take appropriate measures to detect or prevent
possible errors in the connecting wiring.
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3.4 Operational environment and operation
The products are subject to sales restrictions in accordance with EN IEC 61800-3.

The products are not designed for use in a public low-voltage network that supplies residential areas. Radio-frequency
interference can be expected if the products are used in this type of network.

The products are intended exclusively for installation in control cabinets with at least protection class IP54.

Always operate the products within the limits specified by the technical data.

The following applications are prohibited:

§ Use in potentially explosive atmospheres

§ Use in environments with harmful substances as specified by EN 60721, such as oils, acids, gases, vapors, dust and
radiation

Implementation of the following applications is permitted only after approval from STOBER:

§ Use in non-stationary applications

§ The use of active components (drive controllers, supply modules, energy recovery units or discharge units) from third-
party manufacturers

The products are designed exclusively for operation in TN networks or on wye sources.

The drive controller has a configurable restart. If the drive controller is designed for an automatic restart after energy
shutdown, this must be clearly specified on the system in accordance with EN 61800-5-1.

The drive controller has the option of a Safe Torque Off safety function (STO) in accordance with EN 61800-5-2 for safely
disconnecting the energy supply to the motor. Measures based on this for protection against unexpected startup are
described in EN ISO 12100 and EN ISO 14118, for example.

3.5 Disposal
Observe the current national and regional regulations when disposing of the packaging and product! Dispose of the
packaging and individual product parts depending on their properties, e.g. as:

§ Cardboard

§ Electronic waste (circuit boards)

§ Plastic

§ Sheet metal

§ Copper

§ Aluminum

§ Battery
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4 Network structure
A PROFINET network generally consists of a PROFINET segment with a controller (IO controller) and all IO devices belonging
to this segment, i.e. SD6 series drive controllers and a PC as the IO supervisor.

The PROFINET network structure is generally tailored to the specific requirements of the respective system. STOBER drive
controllers support a star, line or tree topology.

All PROFINET nodes are integrated into the PROFINET network using internal or external switches (100 Mbps).

You can configure and parameterize the drive controllers using the DriveControlSuite DS6 software from STOBER; Siemens
TIA Portal lets you do this for the entire PROFINET network, for instance.

The following graphic presents an abstract of a PROFINET network.

PROFINET

IO devices
3 x drive controllers

IO controller
SIMATIC S7-1500

Co
m

m
an

d 
le

ve
l

Co
nt

ro
lle

r l
ev

el

IO supervisor
commissioning

Fi
el

d 
le

ve
l

Commissioning

SD6

Fig. 1: PROFINET: Network structure
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5 PN6 communication module
The drive controllers of the SD6 series are connected with the controller via the PN6 communication module, which
provides the necessary fieldbus interface.

The communication module matches the PROFINET IO standard and enables cyclical and acyclical data exchange between
the drive controllers and the controller.

5.1 Installation
Installation work is permitted only when no voltage is present. Observe the 5 safety rules in accordance with DIN VDE 0105.

In order to prevent the drive controller from overheating, note the minimum clearances listed in the technical data during
installation.

Protect the device against falling parts (wire scraps, wires, pieces of metal, etc.) during installation or other work in the
control cabinet. Parts with conductive properties may result in a short circuit or failure inside the drive controller.

Remove the additional covers before commissioning so that the drive controller does not overheat.

WARNING!

Electrical voltage! Risk of fatal injury due to electric shock!

▪ Always switch off all power supply voltage before working on the devices!

▪ Note that the discharge time of the DC link capacitors is up to 6 minutes. You can only determine the absence of
voltage after this time period.

ATTENTION!

Damage to property due to electrostatic discharge!

Take appropriate measures when handling exposed circuit boards, e.g. wearing ESD-safe clothing.

Do not touch contact surfaces.

Tool and material

You will need:

§ A TORX screwdriver TX10

§ The cover and screws included with the communication module

Installation

1. Unscrew the fastening screw of the dummy cover on top of the drive controller and remove the cover.

2. Slide the communication module on the guide rails into the drive controller.

3. Press on the module in order to push the pin contacts into the box header.

4. Set the tabs of the cover included with the communication module in front in the notch at an angle.

5. Place the cover on the drive controller so that the tabs lie under the edge.

6. Attach the cover using both screws.
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6 Connection
For network connection, PROFINET only allows switches; these in turn allow for flexible network structure and nearly
unlimited network expansion of several kilometers at maximum speed.

6.1 Selecting suitable lines
The PROFINET transmission technology is based on the Fast Ethernet standard.

The connections between the nodes of a PROFINET network generally consist of symmetrical, shielded copper cables
twisted in pairs (shielded twisted pair, CAT 5e quality level). Fiber-optic cables are also a possible means of transmission.

Signals are transmitted according to the 100BASE TX method, i.e. with a transfer rate of 100 Mbps at a frequency of
125 MHz. A maximum of 1440 bytes can be transferred per frame. The maximum cable length is 100 m.

PROFINET cables exist in different versions that are tailored to different application scenarios and ambient conditions.

We recommend using the cables and plug connectors specified in the PROFINET installation guidelines. They are adjusted
for use in automation technology with regard to usage, resistance, EMC properties and color coding.

There are type A, B and C cables, differentiated by installation type:

§ Type A
4-wire shielded copper cable for fixed installation

§ Type B
4-wire shielded copper cable for flexible installation

§ Type C
4-wire shielded copper cable for constant movements

6.2 X200, X201: Fieldbus connection
In order to be able to connect the drive controllers to other PROFINET nodes, an integrated switch with both X200 and X201
RJ-45 sockets is provided. The sockets are located on top of the device. The associated pin assignment and color coding
correspond to the EIA/TIA-T568B standard.

Socket Pin Designation Function

1|2| ... |7|8 1 Tx+ Communication

2 Tx−

3 Rx+

4 — —

5 — —

6 Rx− Communication

7 — —

8 — —

Tab. 2: X200 and X201 connection description
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7 What you should know before commissioning
The following chapters provide a quick introduction to the structure of the program interface and accompanying window
designations as well as relevant information about parameters and generally saving your project configuration.

7.1 Program interfaces
The following chapters include an overview of the program interfaces for the described software components.

7.1.1 DS6 program interface
Using the graphical interface of the DriveControlSuite commissioning software (DS6), you can project, parameterize and
commission your drive project quickly and efficiently. In case of service, you can evaluate diagnostic information such as
operating states, fault memories and fault counters of your drive project using DriveControlSuite.

Information

The program interface of DriveControlSuite is available in German, English and French. To change the language of the
program interface, select Settings > Language.
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1 2

3

4

5

6 7 8
9

Fig. 2: DS6: Program interface

No. Area Description

1 Menu bar Using the File, View, Settings and Window menus, you can open and save projects, display
and hide program windows, select the interface language and access level and change
between different windows in the workspace.

2 Toolbar The toolbar enables quick access to frequently needed functions, like opening and saving
projects and hiding and displaying windows in the program interface.

3 Project tree The project tree forms the structure of your drive project in the form of modules and drive
controllers. Select an element using the project tree first in order to edit it using the
project menu.

4 Project menu The project menu offers you various functions for editing the project, module and drive
controller. The project menu adapts to the element that you selected in the project tree.

5 Workspace The different windows which can be used to edit your drive project, such as the
configuration dialog, wizards, the parameter list or the scope analysis tool, open in the
workspace.

6 Parameter check The parameter check points out irregularities and inconsistencies that were detected in
the plausibility check of calculable parameters.

7 Messages The entries in the messages log the connection and communication status of the drive
controllers, incorrect inputs caught by the system, errors when opening a project or rule
violations in the graphical programming.

8 Variable parameter
lists

You can use variable parameter lists to compile any parameters in individual parameter
lists for a quick overview.

9 Status bar In the status bar, you can find the specifications of the software version and get additional
information about the project file, the devices and the progress of the process during
processes such as loading projects.
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7.1.1.1 Individualized workspace

The project tree (1) and project menu (2) are connected and, like the parameter check and messages (5, 6), can also be
docked at the left, right or bottom edge of the screen. This program window can also be displayed or hidden using the View
menu.

The workspace (3) and parameter description (4) are also connected to each other and always positioned in the middle.
Both areas can be minimized or maximized.

7.1.1.2 Navigation using sensitive circuit diagrams

Fig. 3: DriveControlSuite: Navigation using text links and symbols

In order to illustrate graphically the processing sequence of actual and set values, the use of signals or certain drive
component arrangements and to make configuring the accompanying parameters easier, they are displayed on the
respective wizard pages of the workspace in the form of circuit diagrams.

Blue text links or clickable icons indicate links within the program. These refer to the corresponding wizard pages and, as a
result, allow you to reach additional helpful detail pages with just a click.
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7.1.2 TIA Portal program interface
The Siemens Totally Integrated Automation Portal (TIA Portal) offers a platform you can use to commission your PROFINET
system. The TIA Portal is broken down into the portal view and the project view.

TIA portal view

The TIA overall functionality is broken down into different task areas that you can reach using portals. The following graphic
shows the interface elements of the TIA portal view relevant to this documentation.

1 2

3

Fig. 4: TIA Portal: Program interface of the portal view

No. Area Description

1 Portal selection The portal selection offers you access to various portals for different tasks and functions.

2 Portal functions Depending on the selected portal, the portal functions are available here.

3 Project view The button lets you change to the project view.
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TIA project view

The TIA project view offers you access to all components of a project. The following graphic shows the interface elements of
the TIA portal view relevant to this documentation.

1

2

3

4

5

6

Fig. 5: TIA Portal: Program interface of the project view

No. Area Description

1 Project navigation Project navigation offers you access to all components of your TIA project.

2 Detail view The detail view shows you additional information about a selected object.

3 Workspace In the workspace, you can edit objects in the topology view, network view or device view,
for example.

4 Inspector window The inspector window shows you additional information about a selected object.

5 Task cards Task cards are available depending on the selected object and grant you access to the
hardware catalog, online tools, tasks or libraries, for example.

6 Portal view The button lets you change to the portal view.
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7.2 Meaning of parameters
You can adapt the function of the drive controller to your individual application using parameters. In addition, parameters
visualize the current actual values (actual velocity, actual torque, etc.) and trigger actions like Save values, Test phase, etc.

Interpretation of parameter identification

Parameter identification consists of the following elements, where short forms are also possible, i.e. only specifying a
coordinate or the combination of coordinate and name.

E50 V0

Coordinate Name Version

Drive controller G6

Drive controller
generation/series

7.2.1 Parameter groups
Parameters are assigned to individual groups by topic. The 6th generation of STOBER drive controllers differentiates
between the following parameter groups.

Group Topic

A Drive controllers, communication, cycle times

B Motor

C Machine, velocity, torque/force, comparators

D Set value

E Display

F Terminals, analog and digital inputs and outputs, brake

G Technology – Part 1 (application-dependent)

H Encoders

I Motion (all motion settings)

J Motion blocks

K Control panel

L Technology – Part 2 (application-dependent)

M Profiles (application-dependent)

N Additional functions (application-dependent; extended cam control unit)

P Customer-specific parameters (programming)

Q Customer-specific parameters, instance-dependent (programming)

R Production data for the drive controller, motor, brakes, motor adapter, gear unit and geared motor

S Safety (safety technology)

T Scope

U Protection functions

Z Fault counter

Tab. 3: Parameter groups
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7.2.2 Parameter types and data types
In addition to topic-based sorting in individual groups, all parameters belong to a certain data type and parameter type. The
data type of a parameter is displayed in the parameter list, properties table. The connections between parameter types,
data types and their value range can be found in the following table. 

Type Style Length Value range (decimal)

INT8 Integer or selection 1 byte (signed) -128 – 127

INT16 Integer 2 bytes (1 word, signed) -32768 – 32767

INT32 Integer or position 4 bytes (1 double word,
signed)

-2147483648 – 2147483647

BOOL Binary number 1 bit (internal: 
LSB in 1 byte)

0, 1

BYTE Binary number 1 byte (unsigned) 0 – 255

WORD Binary number 2 bytes (1 word, unsigned) 0 – 65535

DWORD Binary number or parameter
address

4 bytes (1 double word,
unsigned)

0 – 4294967295

REAL32
(single type according to
IEE754)

Floating-point number 4 bytes (1 double word,
signed)

-3.40282 × 1038 – 3.40282 ×
1038

STR8 Text 8 characters —

STR16 Text 16 characters —

STR80 Text 80 characters —

Tab. 4: Parameters: Data types, styles, possible values

Parameter types: Use

§ Integer, floating-point number
For general computing processes
Example: Set and actual values

§ Selection
Numeric value to which a direct meaning is assigned
Example: Sources for signals or set values

§ Binary number
Bit-oriented parameter information that is collected in binary
Example: Control and status words

§ Position
Integer combined with associated units and decimal places
Example: Actual and set values of positions

§ Velocity, acceleration, deceleration, jerk
Floating-point number combined with the associated units and decimal places
Example: Actual and set values for velocity, acceleration, deceleration, jerk

§ Parameter address
Corresponds to the storage location of another parameter
Example: Indirect read sources for analog and digital outputs and for fieldbus mapping

§ Text
Outputs or messages
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7.2.3 Parameter types
The following types of parameters are differentiated.

Parameter type Description Example

Simple parameters Consist of one group and one line with a
defined value.

A21 Brake resistor R: Value = 100 ohms

Array parameters Consist of a group, a line and multiple
sequential (listed) elements, which have the
same properties but different values.

A10 Access level

§ A10[0] access level: Value = Access level
via operating unit

§ A10[2] access level: Value = Access level
via CANopen and EtherCAT

§ A10[4] access level: Value = Access level
via PROFINET

Record parameters Consist of a group, a line and multiple
sequential (listed) elements, which can have
different properties and different values.

A00 Save values

§ A00[0] Start: Value = Start action

§ A00[1] Progress: Value = Display action
progress

§ A00[2] Result: Value = Display action
result

Tab. 5: Parameter types

7.2.4 Parameter structure
Every parameter has specific coordinates with the following pattern.

E200 [0]

Axis
Group

Line

1.

Element

§ Axis
The axis to which a parameter is assigned in the case of multiple axes (optional).

§ Group
The thematic group to which a parameter belongs.

§ Line
Distinguishes the parameters within a parameter group.

§ Element
Elements of an array or record parameter (optional).
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7.2.5 Parameter visibility
The visibility of a parameter depends on the access level defined in the software, the dependency of other parameters, the
selected application and the version of the associated firmware.

Access level

The access options for the individual software parameters are ranked hierarchically and divided into individual levels. This
means that parameters can be hidden for a specific purpose and, relatedly, their configuration options can be locked
starting from a specific level. The following levels are present:

§ Level 0
Elementary parameters

§ Level 1
Important parameters of an application

§ Level 2
Important parameters for service with extensive diagnostic options

§ Level 3
All parameters needed for commissioning and optimizing an application

Parameter A10 Access level controls general access to parameters:

§ Over the SD6 drive controller display (A10[0])

§ Over CANopen or EtherCAT (A10[2])

§ Over PROFINET (A10[3])

Hiding functions

Hiding functions are used to hide parameters with regard to their logical relationships to other option modules or
parameters.

For example, a drive controller can evaluate an encoder using terminal X120, provided that terminal module XI6 has been
installed. The accompanying evaluation is activated using parameter H120. However, this parameter is visible only if
terminal module XI6 was initially selected during the drive project configuration.

Information

It is not possible to write to or read the parameter hidden in DriveControlSuite during communication via fieldbus.

Applications

Applications generally differ in terms of functions and their activation. For this reason, different parameters are available
with each application.

Firmware

A newer version of the firmware may introduce new parameters. Parameters that have been configured for files of an older
firmware function may not be visible in newer versions. In such cases, the respective parameter description includes a
corresponding note.
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7.3 Signal sources and process data mapping
The transmission of control signals and set values in DriveControlSuite meets the following principles.

Signal sources

Drive controllers are either controlled over a fieldbus, using mixed operation consisting of a fieldbus system and terminals
or exclusively using terminals. 
You can use the corresponding selection parameters, referred to as data sources, to configure whether the control signals
and set values of the application are obtained over a fieldbus or using terminals.

In case of activation over a fieldbus, parameters that are selected as data sources for control signals or set values must be
part of the subsequent process data mapping; in the case of activation using terminals, the respective analog or digital
inputs are specified directly.

Process data mapping

If you are working with a fieldbus system and have selected the source parameters for control signals and set values,
configure the fieldbus-specific settings, e.g. the layout of process data channels for transmitting receive and transmit
process data, as the last step.

7.4 Power-loss protected storage
All project configurations, parameterizations and related changes to parameter values are in effect after transmission to the
drive controller, but are not yet stored in non-volatile memory.

Saving to a drive controller

You have the following options for saving the configuration to a drive controller in non-volatile memory:

§ Saving the configuration using the Save values wizard:
Project menu > Wizards area > Projected axis > Save values wizard: Select the Save values action

§ Saving the configuration using the parameter list:
Project menu > Parameter list area > Projected axis > Group A: Drive controller > A00 Save values: Set the parameter
A00[0] to the value 1: Active

§ Saving the configuration using the operating unit:
SD6 drive controller > Operating unit: Press the save button for 3 seconds

Saving to all drive controllers within a project

You have the following options for saving the configuration to multiple drive controllers in non-volatile memory:

§ Saving the configuration using the toolbar:
Toolbar > Save values symbol: Click on the Save values symbol

§ Saving the configuration using the Online connection window:
Project menu > Online connection area > Projected axis > Online connection window: Click on Save values (A00)

Information

Do not shut off the drive controller while saving. If the supply voltage to the control unit is interrupted while saving, the
drive controller starts without an executable configuration when it is next switched on. In this case, the configuration must
be transferred to the drive controller again and saved in non-volatile memory.
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8 Commissioning
The following chapters describe the commissioning a PROFINET network, consisting of a controller from Siemens and
multiple drive controllers from STOBER, with the help of the STOBER DriveControlSuite and the Siemens TIA Portal.

We put forward the following system environment as an example so that you can better follow the individual
commissioning steps:

§ Drive controllers of the SD6 series in firmware version 6.5-D or later

§ DS6 commissioning software in version 6.5-D or later

in combination with

§ Siemens SIMATIC S7-1500 controller

§ Siemens Totally Integrated Automation Portal (TIA Portal) V16 automation software

Commissioning is divided into the following steps:

1. DriveControlSuite:
Project all drive controllers (device control, application, process data, axis model, etc.), parameterize all general
PROFINET settings as well as the PZD transmission, then transmit your configuration to the drive controllers of your
PROFINET network.

2. TIA Portal:
Next, map your actual PROFINET network in TIA Portal and configure the individual nodes. Transfer the configuration
to the controller and start up your PROFINET network.

Information

Before you start commissioning your PROFINET network using DriveControlSuite and TIA Portal, you must network all nodes
of your PROFINET network with each other.
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8.1 DS6: Configuring the drive controller
Project and configure all drive controllers for your drive system in DriveControlSuite DS6 (see the chapter DS6 program
interface [} 16]).

Information

The steps required for commissioning PROFINET are described based on the drive-based Drive Based application in
combination with Drive Based device control.

The process for mapping your axis model and parameterizing the Drive Based device control or the different operating
modes of the Drive Based application can be found in the accompanying manual (see the chapter Detailed information
[} 72]).

Information

Always perform the steps described below in the specified order!

Some parameters are interdependent and do not become accessible to you until you have first configured certain settings.
Follow the steps in the specified sequence so that you can finish the parameterization completely.
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8.1.1 Initiating the project
In order to be able to configure all drive controllers and axes of your drive system using DriveControlSuite, you must record
them as part of a project.

8.1.1.1 Projecting the drive controller and axis

Create a new project and project the first drive controller along with the accompanying axis.

Creating a new project

1. Start DriveControlSuite.

2. On the start screen, click Create new project.

ð The new project is created and the configuration dialog for the first drive controller opens.

ð The Drive controller button is active.

Projecting the drive controller

1. Properties tab: 
Establish the relationship between your circuit diagram and the drive controller to be projected in DriveControlSuite.
Reference: Specify the reference code (equipment code) of the drive controller.
Designation: Give the drive controller a unique name.
Version: Version your project configuration.
Description: If necessary, specify additional supporting information, such as the change history of the project
configuration.

2. Drive controller tab:
Select the series and device type of the drive controller.

3. Option modules tab:
Communication module: Select the PN6 communication module.
Terminal module: If you are controlling the drive controller in mixed operation, i.e. via analog and digital inputs as well
as the PN6, select the corresponding terminal module.
Safety module: If the drive controller is part of a safety circuit, select the corresponding safety module.

4. Device control tab:
Device control: Select Drive Based.
Rx process data, Tx process data: Select PROFINET Rx and PROFINET Tx for transmitting PROFINET process data.

Information

Make sure that you project the correct series in the Drive controller tab. The projected series cannot be changed
afterwards.
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Projecting the axis

1. Click on Axis 1.

2. Properties tab: 
Establish the connection between your circuit diagram and the axis to be projected in DriveControlSuite.
Reference: Specify the reference code (equipment code) of the axis.
Designation: Give the axis a unique name.
Version: Version your project configuration.
Description: If necessary, specify additional supporting information, such as the change history of the project
configuration.

3. Application tab: 
Select Drive Based.

4. Motor tab: 
Select the type of motor operated using this axis. If you are working with motors from third-party suppliers, enter the
accompanying motor data at a later time.

5. Confirm with OK.

8.1.1.2 Configuring safety technology

If the drive controller is part of a safety circuit, you must configure the safety technology in accordance with the
commissioning steps outlined in the corresponding manual in the next step.
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8.1.2 Parameterizing general PROFINET settings

ü You have projected the PROFINET Rx and PROFINET Tx process data for the drive controller.

1. Highlight the relevant drive controller in the project tree and click on the first projected axis in the project menu >
Wizard area.

2. Select the PROFINET wizard.

3. A100 Fieldbus scaling:
Leave the default setting at 1: Native (values are passed unchanged).

4. A273 PN device name:
Shows the PROFINET device name that was assigned in TIA Portal if there is an online connection between the drive
controller and controller.

5. A109 PZD-Timeout:
Define the time that results from the tolerated failure time for monitoring the PZD communication plus the watchdog
time of the controller (TIA Portal: response monitoring time) in the PROFINET network (default value: 20 ms).
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8.1.3 Configuring PZD transmission
The PZD channel (process data transmission channel) serves to transfer control and status information as well as actual and
set values between a controller (IO controller) and drive controller (IO device) cyclically in real time.

The direction of data flow is important in this data exchange. From the perspective of the drive controller, PROFINET IO
distinguishes between receive PZD (RxPZD) and transmit PZD (TxPZD). STOBER drive controllers of the 6th generation
support a flexible assignment of the parameter values to be transmitted.

The RxPZD and TxPZD process data that is exchanged between the controller and drive controller during cyclical data
transmission depends on the projected application. In the PROFIdrive application, the mapping of the process data is
specified by the controller in online operation. In Drive Based applications, the process data is pre-assigned by the standard
mapping accordingly. Check the standard mapping and adjust it if necessary.

Information

The PZD processing is WORD-oriented in some controllers (16 bit). In Drive Based applications, the standard mapping is pre-
assigned appropriately. If changes are made to the standard mapping, take the parameter data type that you are adding to
or removing from the mapping into account.

If you add or remove parameters of the BYTE or INT8 data type (8 bit), this can cause problems in the data structures of the
controller. If necessary, use parameter A101 Dummy byte to fill the 8-bit gaps that result in the process data and implement
the necessary data structure for the controller.

8.1.3.1 Adapting RxPZD

Information

You define the scope of transmission of cyclical PZD in TIA Portal by projecting a corresponding process data module for
each axis of the drive controller.

ü You have projected the Drive Based application.

1. Highlight the relevant drive controller in the project tree and click on the first projected axis in the project menu >
Wizard area.

2. Select the PROFINET wizard > Received process data RxPZD.

3. Check the standard mapping and adapt it to your requirements if necessary.
A90[0] – A90[5], A91[0] – A91[5], A92[0] – A92[5]: 
Target parameters whose values are received by the drive controller from the controller. The position provides
information about the receiving sequence.

4. Resulting data length:
Shows the overall length of the PZD to be transmitted if there is an online connection to the controller. The value
must not exceed the data volume of the process data module that you project in TIA Portal.1

1 Max. 72 bytes/36 words
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8.1.3.2 Adapting TxPZD

Information

You define the scope of transmission of cyclical PZD in TIA Portal by projecting a corresponding process data module for
each axis of the drive controller.

ü You have projected the Drive Based application.

1. Highlight the relevant drive controller in the project tree and click on the first projected axis in the project menu >
Wizard area.

2. Select the PROFINET wizard > Transmitted process data TxPZD.

3. Check the standard mapping and adapt it to your requirements if necessary.
A94[0] – A94[5], A95[0] – A95[5], A96[0] – A96[5]: 
Source parameters whose values the drive controller sends to the controller. The position provides information about
the transmission sequence.

4. Resulting data length:
Shows the overall length of the PZD to be transmitted if there is an online connection to the controller. The value
must not exceed the data volume of the process data module that you project in TIA Portal.2

2 Max. 72 bytes/36 words
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8.1.4 Mapping the mechanical axis model
To be able to put your real drive train with one or more drive controllers into operation, you must map your complete
mechanical environment in DriveControlSuite.

8.1.4.1  Parameterizing the STOBER motor

You have projected a STOBER synchronous servo motor with EnDat 2.1/2.2 digital encoder and optional brake.

By projecting the corresponding motor, limit values for currents and torques as well as associated temperature data are
automatically transferred to the respective parameters of the individual wizards. All additional data on the brake and
encoder is transferred at the same time.

Motor protection

All models of the 6th STOBER drive controller generation feature a certified i²t model, a computational model for thermal
monitoring of the motor. In order to activate it and start the protective function, set the parameters as follows (deviating
from the default values): U10 = 2: Warning and U11 = 1.00 s. This model can be used instead of or in addition to
temperature-monitored motor protection.

8.1.4.2 Parameterizing the axis model

Parameterize the setup of your drive in this order:

§ Define the axis model

§ Scale the axis

§ Parameterize the position and velocity window

§ Limit the axis (optional)

• Limit the position

• Limit the velocity, acceleration and jerk

• Limit the torque and force
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8.1.4.2.1 Define the axis model

1. Highlight the relevant drive controller in the project tree and click on the first projected axis in the project menu >
Wizard area.

2. Select the Axis model wizard.

3. I05 Type of axis:
Define whether the axis type is rotational or translational.

3.1. If you would like to configure the units of measure and the number of decimal places individually for specifying
and displaying position set values, velocities, accelerations and jerk, select 0: User defined, rotational or 1:
User defined, translational.

3.2. If the units of measure and the number of decimal places for specifying and displaying position set values,
velocities, accelerations and jerk are to be fixed, select 2: Rotational or 3: Translational.

4. B26 Motor encoder:
Define the interface to which the motor encoder is connected.

5. I02 Position encoder (optional):
Define the interface to which the position encoder is connected.

6. I00 Position range:
Define whether the travel range of the axis is limited or endless (modulo).

7. If you have selected 1: Endless for I00, parameterize a revolution length (see Scale the axis [} 35]).

Information

If you parameterize I05 Type of axis, you can either use the selections 0: User defined, rotational or 1: User defined,
translational to configure units of measure and the number of decimal places for the axis model individually or use the
selections 2: Rotational and 3: Translational to revert to default values.

Selecting 2: Rotational sets the following units of measure for the axis model: position in °, velocity in rpm, acceleration in
rad/s2, jerk in rad/s3.

Selecting 3: Translational sets the following units of measure for the axis model: position in mm, velocity in m/s,
acceleration in m/s2, jerk in m/s3

Information

If you do not parameterize it differently for I02 Position encoder, B26 Motor encoder is used for position control as
standard.
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8.1.4.2.2 Scale the axis

1. Highlight the relevant drive controller in the project tree and click on the first projected axis in the project menu >
Wizard area.

2. Select the Axis model wizard > Axis: Scaling.

3. Scale the axis by configuring the overall gear ratio between the motor and output.
To simplify this scaling for you, you are provided with the scaling calculator Conversion of position, velocities,
accelerations, torque/force, which calculates the effects of changed movement variables on the entire system.

4. I01 Circular length:
If you have selected 1: Endless for I00 Position range, enter the revolution length.

5. I06 Decimal places position (optional):
If you have selected 0: User defined, rotational or 1: User defined, translational for I05 Type of axis, define the desired
number of decimal places.

6. I09 Measure unit (optional):
If you have selected 0: User defined, rotational or 1: User defined, translational for I05 Type of axis, define the desired
unit of measure.

Information

A change to parameter I06 moves the decimal separator for all axis-specific values!
Ideally, change I06 before parameterizing other axis-specific values and then check them afterwards.

Information

Parameter I297 Maximum speed position encoder must be parameterized according to your application case. If I297 is set
too low, the permitted maximum speed is exceeded even at normal operating speeds. On the other hand, if I297 is set too
high, measuring errors of the encoder can be overlooked.

I297 depends on the following parameters: I05 Type of axis, I06 Decimal places position, I09 Measure unit as well as
I07 Distance factor numerator position and I08 Distance factor denominator position for Drive Based or A585 Feed constant
for CiA 402. If you have made changes to one of the parameters listed, select I297 accordingly as well.

8.1.4.2.3 Parameterize the position and velocity window

Enter position limits and velocity zones for set values. To do so, parameterize boundary values for reaching a position or
velocity.

1. Select the Axis model wizard > Window position, velocity.

2. C40 Velocity window: 
Parameterize a tolerance range for velocity tests.

3. I22 Target window: 
Parameterize a tolerance range for position tests.

4. I87 Actual position in window time:
Parameterize how long a drive must stay in the specified position range before a corresponding status message is
output.

5. Parameterize a tolerance range for lag tests.
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8.1.4.2.4 Limiting the axis

If necessary, limit the movement variables for position, velocity, acceleration, jerk as well as torque/force according to the
applicable conditions for your axis model.

Limiting the position (optional)

1. Highlight the relevant drive controller in the project tree and click on the first projected axis in the project menu >
Wizard area.

2. Select the Axis model wizard > Limit: Position.

3. If necessary, limit the position of your axis using a software or hardware limit switch to secure the travel range.

Limiting velocity, acceleration, jerk (optional)

The specified default values are designed for slow velocities without gear units. For this reason, adapt the saved values.

Note that the velocity of the motor is parameterized in units other than that of the axis model. Verify the velocity of the
motor against the velocity of the output accordingly.

1. Select the Motor wizard.

2. To determine the maximum velocity at the output, copy the value of the B13 Nominal motor speed parameter to the
clipboard.

3. Select the Axis model wizard > Axis: Scaling > Conversion of positions, velocities, accelerations, torque/force area.

4. Velocity line: 
Paste the copied value of the B13 parameter from the clipboard without the unit and confirm with ENTER.

ð The maximum velocity of the motor has been transferred to the output.

5. Select the Axis model wizard > Limit: Velocity, acceleration, jerk.

6. I10 Maximal speed: 
Limit the maximum velocity of the output taking into account the configured Nominal motor speed in B13.

7. Determine the limiting values for acceleration and jerk if necessary and enter them into the associated parameters.

Limiting torque/force (optional)

The specified default values take into account the rated operation together with the overload reserves.

1. Select the Axis model wizard > Limit: Torque/force.

2. If the motor force must be limited, adapt the saved values as necessary.
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8.1.5 Transmitting and saving the configuration
In order to transmit and save the configuration to one or more drive controllers, you must connect your PC and the drive
controllers over the network.

WARNING!

Injury to persons and material damage due to axis movement!

If there is an online connection between DriveControlSuite and the drive controller, changes to the configuration can lead
to unexpected axis movements.

▪ Only change the configuration if you have visual contact with the axis.

▪ Make sure that no people or objects are within the travel range.

Information

During the search, all drive controllers within the broadcast domain are found via IPv4 limited broadcast.

Prerequisites for finding a drive controller in the network:

▪ Network supports IPv4 limited broadcast

▪ All drive controllers are in the same subnet (broadcast domain)

Transmitting the configuration

ü The drive controllers are switched on.

1. In the project tree, highlight the module under which you have recorded your drive controller and click Online
connection in the project menu.

ð The Add connection window opens. All drive controllers found via IPv4 limited broadcast are displayed.

2. Direct connection tab > IP address column: 
Activate the IP addresses in question and confirm your selection with OK.

ð The Online connection window opens. All drive controllers connected through the selected IP addresses are
displayed.

3. Select the drive controller to which you would like to transfer the configuration. Change the selection of transmission
type from Read to Send.

4. Change the selection Create new drive controller:
Select the configuration that you would like to transfer to the drive controller.

5. Repeat steps 3 and 4 for all other drive controllers to which you would like to transfer your configuration.

6. Online tab:
Click on Establish online connections.

ð The configurations are transferred to the drive controllers.
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Saving the configuration

ü You have successfully transferred the configurations.

1. Online connection window:
Click on Save values (A00).

ð The Save values (A00) window opens.

2. Click on Start action.

ð The configurations are saved.

3. Close the Save values (A00) window.

4. Online connection window:
Click on Restart (A09).

ð The Restart (A09) window opens.

5. Click on Start action.

6. Confirm the safety instruction with OK.

ð The Restart (A09) window closes.

ð The fieldbus communication and connection to DriveControlSuite are interrupted.

ð The drive controllers restart.
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8.1.6 Activating the control panel and testing the configuration

WARNING!

Injury to persons and material damage due to axis movement!

By activating the control panel, you have sole control over the movements of the axis using DriveControlSuite. If you are
using a controller, it no longer monitors the axis movements after the control panel is activated. The controller cannot
intervene to prevent collisions. The controller takes over control again when the control panel is deactivated, which can
cause unexpected axis movements.

▪ Only use the control panel if you have visual contact with the axis.

▪ Make sure that no people or objects are within the travel range.

ü You have successfully saved the configurations.

ü There must not be any active safety function.

1. Highlight the relevant drive controller in the project tree and click on the first projected axis in the project menu >
Wizard area.

2. Select the Jog control panel wizard.

3. Click Control panel on and then Enable.

ð The drive is controlled using the activated control panel.

4. Move the axis step-by-step and test the direction of motion, velocity, distances, etc. using the Jog+, Jog−, Jog step+
and Jog step− buttons.

5. Optimize your project configuration based on your test results as necessary.

6. To deactivate the control panel, click on Control panel off.

Information

Jog+ and Jog− cause a continual manual movement in the positive or negative direction. Jog step+ and Jog step- move the
axis relative to the current actual position by the increment specified in I14.

Jog+ and Jog− have a higher priority than Jog step+ and Jog step−.
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8.2 TIA Portal: Setting up a PROFINET network
A PROFINET networks generally consists of a controller (IO controller) and multiple drive controllers (IO devices). Using
TIA Portal, map your real PROFINET network in a TIA project, configure all PROFINET nodes and link them logically with each
other. Then, transfer the configuration to the controller and check the cyclical communication.

Information

Always perform the steps described below in the specified order!

Some parameters are interdependent and do not become accessible to you until you have first configured certain settings.
Follow the steps in the specified sequence so that you can finish the parameterization completely.

8.2.1 Installing the GSD file
To be able to map the STOBER drive controllers of your PROFINET network in your TIA project, you must import and install a
STOBER-specific GSD file (general station description file) in your TIA project. STOBER drive controllers are available in the
hardware catalog of your TIA project as soon as the GSD file has been installed.

Information

If you have already downloaded a GSD file from the STOBER download area at an earlier point, make sure that you are using
the current version of the GSD file required.

ü You have downloaded the current version of the GSD file from the STOBER download area and saved it locally.

ü You have created a TIA project and are in the TIA project view.

1. In the menu bar, select Options > Manage general station description files (GSD).

ð The Manage general station description files window opens.

2. Installed GSDs tab, Source path area:
Select the directory in which you have stored the STOBER-specific GSD file and confirm with OK.

ð The GSD file is displayed in the Content of the imported path area.

3. Content of the imported path area:
Select the desired GSD file and click on Install.

ð The GSD file is installed; the STOBER drive controllers are available in the hardware catalog.
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8.2.2 Projecting the PROFINET network
Map the controller and all drive controllers of your PROFINET network in a TIA project by selecting the corresponding
modules from the hardware catalog and incorporating them into the project.

8.2.2.1 Projecting the controller

Project the controller of your PROFINET network.

ü You have created a TIA project and installed the STOBER-specific GSD.

ü You are in the TIA network view; the hardware catalog is open.

1. Hardware catalog:
Select Controller > SIMATIC S7-1500 > CPU and open the folder of the CPU type belong to your controller.

2. Drag and drop the desired controller into the network view.

ð The controller is incorporated into your TIA project.

8.2.2.2 Projecting the drive controller

Project all drive controllers of your PROFINET network.

ü You have created a TIA project and installed the STOBER-specific GSD.

ü You are in the TIA network view; the hardware catalog is open.

1. Hardware catalog: 
Select Other field devices > PROFINET IO > Drives > STOBER ANTRIEBSTECHNIK GmbH & Co. KG > STOBER
ANTRIEBSTECHNIK > STOBER 6th generation drives > PN6A.

2. Drag and drop the desired drive controller into the network view.

ð The drive controller is incorporated into your TIA project.

3. Repeat steps 1 and 2 for all drive controllers of your PROFINET network.

8.2.2.3 Linking the controller and drive controller logically

Establish a logical gate link between the controller and drive controllers in order to enable the communication between the
devices.

ü You are in the TIA network view.

ü You have projected the controller and drive controllers.

1. Click on the port of the controller and drag a connection to the port of the first drive controller while holding the
mouse button.

2. Repeat the process for all drive controllers of your PROFINET network.

ð The controller and drive controllers of your PROFINET network are linked logically with each other.

Information

To be able to link the controller and drive controllers with each other logically, you must be in the TIA network view.
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8.2.3 Configuring the controller
Configure the network addresses for the controller as needed.

8.2.3.1 Configuring network addresses

As needed, you can change the IP address and subnet mask of the controller.

ü You are in the TIA network view.

1. Network view:
Double-click on the controller of your PROFINET network.

ð This switches you to the respective device view; the inspector window shows the device properties.

2. General tab:
Select PROFINET interface > Ethernet addresses in the area navigation.

3. IP protocol area > Set IP address in the project:
If it is not active by default, activate this option and change the IP address and subnet mask of the controller.

ð The IP address and subnet mask of the controller are configured.
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8.2.4 Configuring the drive controller
Assign a device name for the drive controllers of your TIA project to be able to identify them in the PROFINET network.
Then, project the process data modules and configure the settings for PZD transmission between the controller and drive
controller.

8.2.4.1 Assigning device names

Assign a device name for your drive controllers to be able to identify them in the PROFINET network.

ü You are in the TIA network view.

1. Network view:
Double-click on a drive controller of your PROFINET network.

ð This switches you to the respective device view; the inspector window shows the device properties.

2. General tab:
Select General in the area navigation.

ð The general settings for the drive controller open.

3. Name:
Assign a device name for the drive controller that corresponds to the PROFINET naming conventions.

4. Device view: 
Mark the drive controller in question and select Assign device name using its context menu.

ð The Assign PROFINET device name window opens.

5. Click on Update list.

ð All drive controllers are listed that were found in the subnet.

ð Depending on the drive controller, the device type, IP address and MAC address are displayed.

6. Mark the drive controller that you would like to name and click on Assign name.

ð The device name is assigned to the selected drive controller.

Information

Using Flash LED, you can identify which drive controller you have currently selected if multiple drive controllers are found in
the same subnet.

As an alternative, you can identify the drive controller by its MAC address. The MAC address of the drive controller can be
read off in parameter A279 PN MAC addresses in DriveControlSuite (PROFINET wizard > Diagnostics).
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8.2.4.2 Projecting the process data module

Define the data volume for the PZD transmission of the PROFINET communication by projecting a process data module for
each axis.

ü You are in the TIA network view; the hardware catalog is open.

1. Network view:
Double-click on a drive controller of your PROFINET network.

ð This switches you to the respective device view; the inspector window shows the device properties.

2. Hardware catalog > Module > Cat 1: Process data modules (PZD), all consistent:
Select a process data module with a data volume that at least corresponds to your process data map in the drive
controller.

3. Drag and drop the selected module into the device overview of the drive controller at slot 1 provided for this.

4. If you are using a double-axis controller, repeat the process for the second axis and slot 2.

ð The input and output addresses of the drive controller are generated automatically.
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8.2.4.3 Configuring PZD transmission

For the PZD transmission, configure the cycle time for the data exchange as well as the watchdog time for the monitoring of
PROFINET communication between the controller and drive controller.

ü You are in the TIA network view.

1. Network view:
Double-click on a drive controller of your PROFINET network.

ð This switches you to the respective device view; the inspector window shows the device properties.

2. In the area navigation, select PROFINET interface [X1] > Advanced options > Real-time settings > IO cycle.

ð The settings for the IO cycle open.

3. Update time:
Configure the cycle time in which the controller and drive controller exchange data.

3.1. Calculate update time automatically:
If the cycle time is to be calculated automatically, select this option.

3.2. Set update time manually:
If you want to set the cycle time manually, select this option and specify the desired time.

3.3. Adapt update time when send clock changes:
If you have set the cycle time manually and if the ratio between cycle time and transmission cycle is to remain
constant, also select this option.

4. Watchdog time area:
Configure the watchdog time for monitoring the PROFINET communication.

4.1. Accepted update cycles without IO data:
Enter the number of permitted cycles after which the PROFINET watchdog is triggered in case of an
interruption in PROFINET communication.

4.2. Watchdog time:
The watchdog time for PROFINET communication is calculated automatically based on the cycle time and the
permitted cycles without data exchange and must not exceed 1.92 seconds.

Information

The application-dependent cycle time of the drive controller can be read off in parameter A150 Cycle time in
DriveControlSuite.
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8.2.5 Transmitting the configuration
Transmit the configuration of your TIA project from your PC to your controller.

ü You have fully mapped and parameterized your PROFINET network in the TIA project.

1. Project navigation > Devices tab:
Select the folder of the controller in question.

2. Select Online > Advanced download to device in the menu bar.

ð The Advanced download window opens.

3. Select target device area:
Select Show all compatible nodes and click on Start search.

ð All controllers are listed that were found in the subnet.

4. Select the controller where you would like to transfer the configuration and click on Download.

ð The Software synchronization before downloading to a device window opens.

5. Click on Continue without synchronizing.

ð The Preview download window opens.

6. Click on Download.

ð The configuration is transmitted to the selected controller and the Results of the download process window
opens.

7. Click on Finish.

ð The download process is complete; the configuration was transmitted successfully to the controller.

Information

If there is an online connection, you can identify which controller you have currently selected using Flash LED if multiple
controllers are located in the same subnet.
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8.2.6 Testing communication
Check the communication between the controller and drive controllers of your PROFINET network using the diagnostics
buffer of the controller.

ü You have transferred the configuration to the controller.

1. Project navigation > Devices tab:
By double-clicking on Online & diagnostics, open the Online access detail view of the controller in question.

ð This switches you to the respective device view.

2. Online access area:
Click on Connect online.

ð An online connection to the selected controller is being established.

3. In the area navigation, select Diagnostics > Diagnostics buffer.

4. Results area:
Check the events in the diagnostics buffer for possible errors and correct their causes if necessary.

ð The connection between the controller and drive controller is projected and a data exchange between the nodes in
the PROFINET network is possible.

Information

If there is an online connection, you can identify which controller you have currently selected using Flash LED if multiple
controllers are located in the same subnet.

Information

Setup of the PROFINET network is complete. As an option, you can continue by programming the acyclical communication
services, as described in Programming acyclical communication services [} 60].
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9 Monitoring and diagnostics
For monitoring purposes and in the event of a fault, the various monitoring and diagnostic options described below are
available.

9.1 Connection monitoring
In order that the drive does not respond in an unwanted manner in the event of an interruption of the PROFINET
connection (cable break, etc.), we recommend monitoring the arrival of cyclical process data.

PROFINET provides the watchdog time (TIA Portal: response monitoring time) for connection monitoring. This time, in
combination with the cycle time (TIA Portal: update time), defines the IO cycle in the controller (IO controller).

The cycle time determines the interval in which data is transmitted from the controller to the drive controller in question
(IO device) and vice versa. It depends on various factors including the data volume to be transferred and is generally
calculated in TIA Portal automatically for each drive controller.

The watchdog time corresponds to the number of permitted cycles without a data transfer (see the chapter Configuring
PZD transmission [} 45]).

In addition to the watchdog time of the controller, the parameter A109 PZD-Timeout can also be activated in
DriveControlSuite. At the end of the watchdog time projected for the controller, the PZD timeout also takes effect in the
firmware of the drive controller.

Fault 52: Communication

Cause 4: PZD timeout A109 PZD-Timeout

Time

Watchdog time

Connection interruption

Old dataValid data

A109 PZD-Timeout

Fig. 6: PROFINET: Connection monitoring

The configured watchdog time runs down as soon as an error has occurred, and then the timeout parameterized in A109.
Once the timeout has also elapsed, the drive controller changes to the Fault device state with the accompanying event 52:
communication, cause 4: PZD timeout.
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9.2 LED display
The drive controllers feature diagnostic LEDs that visualize the state of fieldbus communication and the states of the
physical connection.

9.2.1 PROFINET state
There are 2 LEDs on the front of the drive controller that provide information about the connection between the controller
and drive controller and about the state of the data exchange. This information can also be read out in parameter A271 PN
state.

X200

B
F-R

u
n

21

Fig. 7: LEDs for the PROFINET state

1 Red: BF (bus error)

2 Green: Run

Red LED Conduct Description

Off No error

Rapid flashing Data exchange with controller not
active

On No network connection

Tab. 6: Meaning of the red LED (BF)

Green LED Conduct Description

Off No connection

Flash Connection is set up to controller

Flash, inverse Controller activates DHCP signal service

Flashing Existing connection to controller; data
exchange expected

On Existing connection to controller

Tab. 7: Meaning of the green LED (Run)
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9.2.2 PROFINET network connection
The Act. and Link LEDs at X200 and X201 on the top of the device indicate the state of the PROFINET network connection.

X200

21 43

X201

B
F-R

u
n

Link Act Link Act

Fig. 8: LEDs for the state of the PROFINET network connection

1 Green: Link at X201

2 Yellow: Activity at X201

3 Green: Link at X200

4 Yellow: Activity at X200

Green LED Behavior Description

Off No network connection

On Network connection exists

Tab. 8: Meaning of the green LEDs (Link)

Yellow LED Behavior Description

Off No data exchange

Flashing Active data exchange with IO controller

Tab. 9: Meaning of the yellow LEDs (Act.)
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9.3 Events
The drive controller has a self-monitoring system that uses test rules to protect the drive system from damage. Violating
the test rules triggers a corresponding event. There is no possible way for you as the user to intervene in some events, such
as the Short/ground event. In others, you can influence the effects and responses.

Possible effects include:

§ Message: Information that can be evaluated by the controller

§ Warning: Information that can be evaluated by the controller and becomes a fault after a defined time span has
elapsed without the cause being resolved

§ Fault: Immediate drive controller response; the power unit is disabled and axis movement is no longer controlled by
the drive controller or the axis is brought to a standstill by a quick stop or emergency braking

ATTENTION!

Damage to property due to interruption of a quick stop or emergency braking!

If, when executing a quick stop or emergency braking, a fault occurs or STO is active, the quick stop or emergency braking is
interrupted. In this case, the machine can be damaged by the uncontrolled axis movement.

Events, their causes and suitable measures are listed below. If the cause of the error is corrected, you can usually
acknowledge the error immediately. If the drive controller has to be restarted instead, a corresponding note can be found
in the measures.

Information

To make it easier for control programmers to set up the human-machine interface (HMI), a list of events and their causes
can be found in the STOBER download center at http://www.stoeber.de/en/downloads/.

http://www.stoeber.de/en/downloads/
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9.3.1 Event 52: Communication
The drive controller is interrupted if:

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes are applied in the event of an inactive release override (F06)

The drive controller has a fault and a quick stop occurs if:

§ A29 = 1: Active for Drive Based or PROFIdrive device control

Response:

§ The axis is stopped by a quick stop; meanwhile, the brakes remain released

§ At the end of the quick stop, the power unit is disabled and the axis movement is no longer controlled by the drive
controller; the brakes engage if release override is inactive (F06)

Cause Check and action

4: PZD-Timeout Missing process data Check the cycle time in the controller and
tolerated failure time for monitoring the PZD
communication in the drive controller and
correct if necessary (A109)

14: PZD parameter figure faulty Missing mapping Check the mapping for unmappable
parameters and correct them if necessary

Tab. 10: Event 52 – Causes and actions
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9.4 Parameters
The following diagnostic parameters are available for you in PROFINET communication in combination with drive controllers
of the SD6 series.

9.4.1 A270 | X20x state | G6 | V0
State of the network connection (fieldbus).

§ [0]: X200

• 0: Error

• 1: No connection
No network cable plugged in

• 2: 10 MBit/s
Connection active; transfer rate of 10 Mbps

• 3: 100 MBit/s
Connection active; transfer rate of 100 Mbps, half-duplex

• 4: Link OK
Connection active; transfer rate of 100 Mbps, full-duplex

§ [1]: X201
See [0]: X200

9.4.2 A271 | PN state | G6 | V0
State of the drive controller in the PROFINET network.

§ 0: offline
Hardware not ready for use

§ 1: step 1
Hardware ready for use; no connection to the IO controller

§ 2: step 2
IP address received; connection to the IO controller is set up

§ 3: phase 1
Drive controller is configured by the IO controller

§ 4: phase 2
Device start-up of IO controller and drive controller completed; process data communication is started

§ 5: cyclic data exchange
Process data communication active

9.4.3 A272 | PN module/submodule | G6 | V1
Module configurations of the drive controller in the PROFINET network (source: IO controller; format: WW XX YYY ZZZ; WW
= module ID, XX = submodule ID, YYY = RxPZD data length in bytes, ZZZ = TxPZD data length in bytes).

§ [0]: Single-axis controller, double-axis controller axis A

§ [1]: Double-axis controller axis B
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9.4.4 A273 | PN device name | G6 | V0
Device name of the drive controller (IO device) in the PROFINET network (source: IO controller).

§ [0] – [2]: Current device name; parts 1 – 3 (additional use: DriveControlSuite connection dialog)

§ [3] – [5]: Device name after the next fieldbus restart; parts 1 – 3

9.4.5 A274 | PN IP address | G6 | V0
IP address of the drive controller in the PROFINET network (source: IO controller).

§ [0]: Current IP address

§ [1]: IP address after the next fieldbus restart

9.4.6 A275 | PN subnet mask | G6 | V0
Subnet mask of the drive controller in the PROFINET network (source: IO controller).

§ [0]: Current subnet mask

§ [1]: Subnet mask after the next fieldbus restart

9.4.7 A276 | PN gateway | G6 | V0
Gateway address of the drive controller in the PROFINET network (source: IO controller).

§ [0]: Current gateway address

§ [1]: Gateway address after the next fieldbus restart

9.4.8 A279 | PN MAC addresses | G6 | V0
MAC addresses of the drive controller in the PROFINET network.

§ [0]: PROFINET device

§ [1]: X200

§ [2]: X201
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10 More on PROFINET?
The following chapters summarize the key terms, services and relationships relating to PROFINET.

10.1 PROFINET
PROFINET (process field network) is the open industrial Ethernet standard for automation from Siemens, developed in
collaboration with the PROFIBUS-Nutzerorganisation e. V. PROFINET is standardized in IEC 61158 and IEC 61784.

PROFINET is based on Ethernet TCP/IP and is primarily used in cases where fast data communication over Ethernet
networks combined with industrial IT functions are needed.

PROFINET IO

PROFINET IO was designed in addition to PROFINET CBA as a technological variant for quick data exchange between a
controller and decentralized field devices (decentral peripherals, DP). PROFINET IO is based on PROFIBUS DP and uses Fast
Ethernet as the means of transmission. Process data (PZD), data for parameterization (parameter channel data), data for
diagnostic purposes, alarms and IT applications are all transferred—over a single network.

PROFINET transmits data with and without a real-time request, while process data and alarms are exclusively transferred
using the real-time communication. PROFINET IO provides two versions in order to scale this optimally:
PROFINET IO-RT for unsynchronized communication and PROFINET IO-IRT for cycle-synchronized real-time communication.

STOBER drive controllers of the 6th generation support PROFINET IO-RT.

PROFINET follows the provider-consumer model where communication partners are on equal footing. Data can be sent
without a request from another network node. Normally, in the case of a data exchange, a controller (IO controller) reads in
the signals from the drive controllers (IO devices), processes them and provides them back to the drive controllers.

10.2 Device classes
PROFINET IO classifies network nodes into the following device classes based on their tasks.

IO supervisor (PC)

An IO supervisor is typically a piece of engineering and diagnostics software that can access all process and configuration
data and process alarms or diagnostic messages. The supervisor is normally only integrated into the network on a
temporary basis.

IO controller (controller)

An IO controller controls data communication, i.e. it receives process data and event-controlled messages and processes
them. A programmable logic controller (PLC, e.g. SIMATIC S7-1500) normally handles the role of the IO controller.

IO device (drive controller)

An IO device is typically a decentrally located field device (e.g. a drive controller) that is assigned to at least one IO
controller.

An IO device transmits process and configuration data as well as alarms. It normally consists of modules that contain the
individual input and output signals of the respective process.
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10.3 Communication
A controller (IO controller) controls and regulates communication with drive controllers (IO devices) in the PROFINET
network. In the process, the controller transmits cyclical process data (PZD), such as control information, to the drive
controllers and receives current status information from them.

In addition, the controller and drive controller acyclically exchange data that is not time-critical, such as configuration
parameter values or one-time events, using parameter channel data.

Both communication services run in parallel, with transmission of cyclical PZD having higher priority. In each cyclical
exchange of data, an acyclical frame is injected as needed.

Information

It is not possible to write to or read the parameter hidden in DriveControlSuite during communication via fieldbus.

10.3.1 Cyclical communication: Process data
Process data (PZD) is normally data that is required for controlling and observing the ongoing process, such as set positions,
travel velocities or acceleration information. 
It is generally used for data exchange in real time. It also gives you simultaneous access to multiple drive parameters.
Process data is exchanged quickly and cyclically with a high priority over the RT real-time channel.

For PROFINET IO, the cyclical data traffic relies directly on the MAC address of a device and does not contain any IP
addresses. This keeps the overall length of a data packet relatively small. 
The direction of data flow is of critical importance in this data transfer. From the perspective of the respective nodes, a
distinction is made between receive PZD (RxPZD) and transmit PZD (TxPZD).

The specific communication elements that are sent and received in specific PZD can be configured for the specific
manufacturer. The length and structure of the process data are defined as part of the project configuration in TIA Portal by
means of the process data modules (see the chapter Process data modules [} 71]).

Currently, per drive controller, 18 parameter values with a maximum total length of 72 bytes (36 words) can be exchanged
between the controller and drive controller.

10.3.2 Acyclical communication: Parameter channel data

Information

If you use the example project provided by STOBER for programming acyclical communication services, this chapter is not
relevant in practice.

The parameter channel is used to transfer data that is not time-critical. Parameter channel data enables read and write
access to the configuration parameters of a drive controller and transfers one-time events.

Parameter channel data is transmitted acyclically in ongoing cyclical PROFINET operation, without impairing PZD
communication. This requires drive-specific acyclical communication services. You can either program them based on the
RDREC and WRREC SIMATIC system function blocks (see the following chapters) or load a STOBER-specific example project
specifically tailored to the STOBER drive controllers of the 6th generation from the STOBER download area in your TIA
Portal and parameterize the parameters appropriately for your system environment.
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10.3.2.1 RDREC and WRREC: Input and output parameters

In order to transfer acyclical parameter channel data, PROFINET offers the Read record and Write record functions. The
associated interfaces are controlled using the RDREC (read record) and WRREC (write record) SIMANTIC system function
blocks that operate asynchronously.

RDREC and WRREC contain special input and output parameters in a defined sequence. Both blocks communicate with the
IO devices in the network using the input and output parameters described below.

RDREC: Input and output parameters

The RDREC block reads a RECORD out of a hardware component addressed in the ID parameter.

REQ

STATUS

ID

LEN

BUSY

ERRORINDEX

MLEN

VALID

= B02E hex 

RECORD

EN ENO

RDREC

DataHeader “Response”

Fig. 9: RDREC system function block: Input and output parameters

Parameters Data type Declaration

EN BOOL IN Release input

REQ BOOL IN Transfer record (REQ = 1: Start transfer)

ID HW_IO IN Hardware identifier for an IO device; is issued automatically and
can be read out in the device properties (System constants tab),
for example

INDEX DINT IN Record number (the associated value must always be B02E hex)

MLEN UINT IN Maximum length of the record to be transferred

ENO BOOL OUT Release output

VALID BOOL OUT Record was received and is valid

BUSY BOOL OUT Status of the reading (BUSY = 1: still not finished)

ERROR BOOL OUT Status of the reading (ERROR = 1: faulty)

STATUS DWORD OUT Status of the RDREC block or error information

LEN UINT OUT Length of the record that was read

RECORD Variant IN/OUT Record (consisting of header + data, see the chapter RDREC,
WRREC: RECORD [} 67])

Tab. 11: Parameters of the RDREC system function block
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WRREC: Input and output parameters

The WRREC system function block transfers the RECORD to a hardware component addressed in the ID parameter.

REQ

ID

STATUS

BUSY

ERRORINDEX

DONE

RECORD

EN ENO

WRREC

DataHeader “Request”

= B02E hex 

Fig. 10: WRREC system function block: Input and output parameters

Parameters Data type Declaration

EN BOOL IN Release input

REQ BOOL IN Transfer record (REQ = 1: Start transfer)

ID HW_IO IN Hardware ID for an IO device; is issued automatically and can be
read out using TIA Hardware Manager > Device > Properties, for
example

INDEX DINT IN Record number (the associated value must always be B02E hex)

ENO BOOL OUT Release output

DONE BOOL OUT Status of the communication: Record was transferred

BUSY BOOL OUT Status of the writing (BUSY = 1: still not finished)

ERROR BOOL OUT Status of the writing (ERROR = 1: faulty)

STATUS DWORD OUT Status of the WRREC block or error information

RECORD Variant IN/OUT Record (consisting of header + data, see the chapter RDREC,
WRREC: RECORD [} 67])

Tab. 12: Parameters of the WRREC system function block
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10.3.2.2 RDREC and WRREC: Acyclical communication flow

The following diagrams clarify the communication flow of the RDREC and WRREC system function blocks.

Read record flow

1. WRREC [Header Request (Request_ID = 0x01)]

2. RDREC

3. RDREC [Header Response (Response_ID = 0x01) + Data]

3. RDREC [Header Response (Response_ID = 0x81) + Data]

Either
parameter value

or
error

Preparation of 
parameter value

IO controller IO device

Fig. 11: RDREC flow

During RDREC, be aware that each parameter service begins with a read record request and ends with a read record
response.

Write record flow

1. WRREC [Header Request (Request_ID = 0x02) + Data ]

2. RDREC

3. RDREC [Header Response (Response_ID = 0x02) + Data]

3. RDREC [Header Response (Response_ID = 0x82) + Data]

Either
OK

or
error

Internal 
processing

IO controller IO device

Fig. 12: WRREC flow
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10.3.3 Programming acyclical communication services
To be able to transfer parameters acyclically, PROFINET provides the Read record and Write record services.

The services are controlled using SIMATIC function blocks RDREC and WRREC. You can either integrate this into the PLC
program yourself or load and parameterize one of the example projects provided for download by STOBER in the TIA Portal.

Information

In the context of the latter, observe the documentation belonging to the example projects.

1. To get the latest project version, switch to the download area on the STOBER website http://www.stoeber.de/en/
downloads/ and enter the term TIA Portal in the search field.

ð The TIA Portal Parameter Services (examples for generation 6) project is displayed in the result list.

2. Start the download and save the file to your PC.

3. Unpack the ZIP file.

ð The ZIP file contains a ZAP15_1 file (SAT_Param_Example_V15_1500) for the SIMATIC S7-1500 controller from
Siemens.

4. TIA Portal: 
Select Project > Retrieve and navigate to the directory where you saved the example project.

5. Open the example project.

ð The example project is loaded in the TIA project view.

6. Project tree > Devices tab: 
Open the folder of the controller > Program blocks

7. G6_Read_Acyclic and G6_Write_Acyclic function blocks:
Parameterize the blocks as described in the documentation of the example project.

Information

Note that only one acyclic access per device may be active at the same time! When using the services in combination with
internal function blocks, access coordination must be resolved in the application.

In the example project provided by STOBER, the xLockAcyclic bit coordinates simultaneous acyclical access to a drive
controller. The bit locks the communication for other blocks. Every block that acyclically accesses a drive controller locks
access using the xLockAcyclic bit and enables it again by resetting the bit as soon as the data exchange has ended.

http://www.stoeber.de/en/downloads/
http://www.stoeber.de/en/downloads/
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10.4 Communication protocols

...

HTTP SNMP

DHCP Standard data Real-time
data

TCP/UDP

IP

Real-time
protocol

Fast Ethernet

PROFINET applicationsIT applications

Fig. 13: PROFINET communication protocols

One protocol optimized for fast Ethernet is suitable for real-time communication: the real-time protocol. 
It allows for a high-performance transfer of cyclical real-time data and event-driven messages.

Standard PROFINET data without a real-time request, such as parameter values or diagnostic data, is usually transferred
using the TCP/IP or UDP/IP protocols. For typical IT applications such as the transfer of websites, e-mails, etc., PROFINET
relies on standard IT protocols such as HTTP or SNMP.
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10.5 Ethernet network addressing
All PROFINET IO nodes are based on the Industrial Ethernet Standard, meaning that the assignment of the following
addresses and names is important to be able to communicate with drive controllers in the PROFINET IO system.

10.5.1 MAC address
Each network interface of a device in an Ethernet network requires its own address – a MAC address. The MAC address is
used as a source and destination address for cyclical data exchange.

A MAC address consists of a fixed and a variable part. The fixed part identifies the manufacturer (3 bytes) and the variable
part distinguishes the individual Ethernet nodes and must be globally unique (also 3 bytes). A MAC address can only
communicate between two nodes of the same subnet.

The MAC addresses of the interfaces are issued by STOBER and cannot be changed.

Information

The MAC address range of the STOBER hardware is: 00:11:39:00:00:00 – 00:11:39:FF:FF:FF

You can read out the MAC address of the PROFINET interface using parameter A279 PN MAC addresses.

10.5.2 IP address
Each PROFINET IO node has to support various Ethernet-based protocols, at least TCP/IP and UDP/IP.

All data packets sent over the IP protocol contain the respective recipient and sender addresses. Consequently, each
PROFINET node needs a unique IP address to be able to receive communication.

The IP protocol is hardware-independent; unlike the fixed MAC address, the IP address is explicitly assigned to each drive
controller.

The IP address is for acyclical data exchange, e.g. transferring the configuration to the controller, configuring the drive
controllers and reading out device and diagnostic information.

An IPv4 address consists of 4 decimal numbers from the value range 0 – 255 separated by a decimal.

Read out the IP address of a drive controller using parameter A274 PN IP address.

10.5.3 Subnet mask
An IP address always consists of a network ID (for identifying the network) and a host ID (for identifying the node). A subnet
mask defines which parts of the IP address are assigned to the network ID. It has the structure of the IP address but only
marks the network ID.

Read out the subnet mask using the A275 PN subnet mask parameter.
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10.5.4 Subnets and gateways
The IP addresses of a network are usually subdivided into subnets. The purpose of subnets is to provide autonomous
networks with an address range. All PROFINET IO nodes connected by switches are in a subnet, meaning that they
communicate over a direct path. All nodes of a subnet have the same subnet mask.

Gateways are components of a subnet and are responsible for forwarding subnet-specific network queries to other
subnets.

Information

Be aware that real-time communication is only possible within a subnet due to addressing with MAC addresses. It is not
possible to use routers for real-time communication via PROFINET.

10.5.5 MAC and IP addressing using device names
To be able to provide unique identification of a drive controller (IO device) in a PROFINET IO system, it must have a symbolic
device name that is unique in the system. It is assigned during the project planning phase in TIA Portal and then transferred
to the drive controllers. The device name is used for parameterizing the individual drive controllers during system start-up
and assigning the respective MAC and IP addresses, the latter using DCP or DHCP.

Observe the following conventions when specifying device names:

§ The device name must be limited to a maximum of 240 characters. 
Letters, numbers, periods and dashes are permitted.

§ A name component, i.e. a character string between 2 periods, may be a maximum of 63 characters long.

§ Special characters like umlauts, brackets, question marks, slashes, spaces, etc. are not allowed.

§ The device name may not begin with numbers.

§ The device name may neither begin nor end with a minus sign (−) or a period (.).

§ The device name may not take the form n.n.n.n (n = 0 – 999).

§ The device name may not begin with the character sequence port-xyz- (x, y, z = 0 – 9).

§ Underscores (_) are not allowed.

10.6 Cycle times
Possible cycle times can be found in the following table.

Type Cycle times Relevant parameters

PROFINET fieldbus, cyclical
communication

1 ms, 2 ms, 4 ms, 8 ms Adjustable in A150

Tab. 13: Cycle times
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11 Appendix

11.1 Standard mapping of PROFINET and Drive Based

Information

The PZD processing is WORD-oriented in some controllers (16 bit). In Drive Based applications, the standard mapping is pre-
assigned appropriately. If changes are made to the standard mapping, take the parameter data type that you are adding to
or removing from the mapping into account.

If you add or remove parameters of the BYTE or INT8 data type (8 bit), this can cause problems in the data structures of the
controller. If necessary, use parameter A101 Dummy byte to fill the 8-bit gaps that result in the process data and implement
the necessary data structure for the controller.

11.1.1 SD6: RxPZD
The following table shows the PROFINET standard RxPZD mapping of the Drive Based and Drive Based synchronous
applications. The mapping is defined in the parameter arrays A90 – A92 and can be adapted individually.

Byte Data type Name Parameters

0 BYTE Control byte device A180

1 BYTE Control byte command 1.J37

2 – 3 WORD Control word application I210

4 SINT Command 1.J40

5 SINT Motion-ID 1.J41

6 – 9 DINT Position 1.J42

10– 13 REAL Velocity 1 1.J43

14 – 17 REAL Velocity Override 1.J56

18 – 21 REAL Torque/Force reference 1.G469

22 BYTE Control byte motion block J01

23 – 24 INT Reference motion block J02

Tab. 14: SD6: PROFINET standard RxPZD mapping
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11.1.2 SD6: TxPZD
The following table shows the PROFINET standard TxPZD mapping of the Drive Based and Drive Based synchronous
applications. The mapping is defined in the parameter arrays A94 – A96 and can be adapted individually.

Byte Data type Name Parameters

0 BYTE Status byte device E200[0]

1 BYTE Status byte device E200[1]

2 – 3 WORD Status word 2 E201

4 BYTE Status byte application 1.I212

5 BYTE Status byte command 1.J39

6 – 7 WORD Status word application I200

8 – 11 DINT Current position 1.I80

12 – 15 REAL Actual speed 1.I88

16 – 19 REAL Actual torque/force E90

20 – 21 WORD Status word user-defined A67

22 SINT Operating condition E80

23 BYTE Status byte motion block J302

24 – 25 INT Actual motion block J300

26 SINT Device control state E48

Tab. 15: SD6: PROFINET standard TxPZD mapping

11.2 Addressing parameters for RECORD record
To be able to address a parameter via fieldbus, you need its Axis_number, Parameter_number and subindex. These are
calculated from the STOBER parameter coordinates (axis, group, line, element).

Basic information on the parameters can be found in the chapter Meaning of parameters [} 21].

11.2.1 Determining the Axis_number
The Axis_number corresponds to the axis of the parameter.
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11.2.2 Calculating the Parameter_number

Information

Note that the Parameter_number in the RECORD record must be specified in hexadecimal form.

The Parameter_number is calculated from the group and line of the parameter according to the following formula:

Parameter_number decimal = 8192 + (number of the group × 512) + number of the line

Calculation example for parameter E200 (number of the group = 4 , 
number of the line = 200):
Parameter_number E200 = 8192 + (4 × 512) + 200 = 10440 = 28C8 hex

Group Number Addressable parameters

A: Drive controller 0 A00 – A511

B: Motor 1 B00 – B511

C: Machine 2 C00 – C511

D: Target value 3 D00 – D511

E: Display 4 E00 – E511

F: Terminals 5 F00 – F511

G: Technology 6 G00 – G511

H: Encoder 7 H00 – H511

I: Motion 8 I00 – I511

J: Motion blocks 9 J00 – J511

K: Control panel 10 K00 – K511

M: Profile 12 M00 – M511

P: Customer-specific parameters 15 P00 – P511

Q: Customer-specific parameters,
instance-dependent

16 Q00 – Q511

R: Production data 17 R00 – R511

S: Safety 18 S00 – S511

T: Scope 19 T00 – T511

U: Safety functions 20 U00 – U511

Z: Fault counter 25 Z00 – Z511

Tab. 16: Groups and parameters

11.2.3 Determining the subindex
The subindex corresponds to the element of the array or record parameter. The subindex of simple parameters is 0.
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11.3 RDREC, WRREC: RECORD

11.3.1 WRREC: RECORD request: Header structure
Parameter values are generally transferred using the RECORD header. For a RECORD request, the header consists of the
following elements in the specified sequence.

Element Data type Value, value range

Request_reference BYTE 0 hex – FF hex Freely selectable request number

Request_ID BYTE 1 hex Read request

2 hex Write request

All other values Reserved

Axis_number BYTE 0 – 3 Addressing the axis

Number_of_parameters BYTE 1 Number of parameters to be processed

All other values Reserved

Attributes BYTE 10 hex Access type: Value

80 hex Access type: Raw value

81 hex Access type: Integer

82 hex Access type: Floating point

Number_of_elements BYTE 1 – 32 hex 1 – 50 Parameters are to be written or
read

Parameter_number WORD 2000 hex – 5FFF hex Group and line of a parameter

Subindex WORD 0 – 3E80 hex Element of an array and record
parameter; in single parameters, the
value = 0

Format
(Condition: Request_ID = 2 hex)

BYTE 8 hex Transfer format: FLOAT

41 hex Transfer format: BYTE

42 hex Transfer format: WORD

43 hex Transfer format: DWORD

1C hex, 1D hex, 1E hex Transfer format: STRING with 8, 16 or 80
characters

Number_of_values
(Condition: Request_ID = 2 hex)

BYTE 1 – 50 Number of values to be processed; 
value = 1 (in a simple parameter) or
value = value of Number_of_elements; 
since a RECORD request may not exceed
a length of 240 bytes, it is not always
possible – depending on the respective
format – to transfer max. 50 elements

1st value
(Condition: Request_ID = 2 hex)

DINT 1st parameter value Value in a simple parameter

2nd value – 50th value
(Condition: Request_ID = 2 hex)

DINT 1 – 32 hex Value = Value of Number_of_elements

Tab. 17: WRREC: RECORD request: Header structure
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11.3.2 RDREC: RECORD response: Header structure
Parameter values are generally transferred using the RECORD header. For a RECORD response, the header consists of the
following elements in the specified sequence.

Element Data type Value, value range

Response_reference BYTE 0 hex – FF hex Value = Request number of RECORD
request

Response_ID BYTE 1 hex Positive answer to a read request

2 hex Positive answer to a write request

81 hex Negative answer to a read request

82 hex Negative answer to a write request

Axis_number BYTE 0 – 3 Addressing the axis

Number_of_parameters BYTE 1 Number of parameters to be processed

Format BYTE 8 hex Transfer format: FLOAT

41 hex Transfer format: BYTE

42 hex Transfer format: WORD

43 hex Transfer format: DWORD

1C hex, 1D hex, 1E hex Transfer format: STRING with 8, 16 or 80
characters

44 hex Error in case of error

Number_of_values BYTE 1 Number of values to be processed

1st value or 
error code

DINT 1st parameter value Value in a simple parameter

WORD Error code in case of error (see table
RDREC, WRREC: Error codes [} 69])

2nd value – 50th value DINT 1 – 32 hex Value = Value of Number_of_elements

Tab. 18: RDREC: RECORD response: Header structure
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11.3.3 RDREC, WRREC: Error codes
The following table shows the possible error codes for the RDREC and WRREC system function blocks.

Error code Cause

0 hex Parameter unfamiliar or configuration stopped

1 hex Access to read-only parameter

2 hex Access to parameter with value outside the limit

3 hex Access to unavailable subindex (array parameter)

B hex User level not reached

11 hex Parameter may not be changed in the current device state; deactivate release

14 hex Invalid value within maximum limits; only occurs in the case of selection parameters with a broken
definition range

16 hex One or more incorrect values in the attribute, Number_of_elements, Parameter_number and subindex
elements

17 hex Invalid format specification

18 hex Contrary value in the Number_of_elements and Number_of_values elements

21 hex Invalid Request_ID = Service not supported; applies to errors in the header of the request block

A5 hex Error cannot be specified in more detail

B0 hex Parameter service currently not possible or valid parameter description not present

B2 hex Unfamiliar parameter address (parameter or element does not exist)

B3 hex Read/write access not possible for specified parameter address

B9 hex Parameter service: Value in definition gap (observe ENUM list)

BA hex Parameter service: Clash with other values

C0 hex Parameter service: Error in pre-read function

C1 hex Parameter service: Error in post-write function; value has already been received

Tab. 19: RDREC, WRREC: Error codes
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11.3.4 Attribute and format elements: Possible combinations
The attribute element describes the access to a parameter structure (e.g. to values, descriptive texts, etc.); the format
element describes the transfer format of a parameter. The values of both elements can be combined as follows.

Attribute Format

FLOAT 
(8 hex)

BYTE 
(41 hex)

WORD 
(42 hex)

DWORD 
(43 hex)

STRING
(1C hex, 1D hex,
1E hex)

Value 
(10 hex)

Not permitted Not permitted Not permitted Scaled value for all
parameters
represented as
integer (4 bytes)

8, 16 or 80
characters

Raw value 
(80 hex)

Unscaled raw
value, specifically
for FLOAT data
type (4 bytes)

Unscaled raw
value, specifically
for BOOL, WORD,
I8 data types
(1 byte)

Unscaled raw
value, specifically
for WORD, I16
data types 
(2 bytes)

Unscaled raw
value, specifically
for DWORD, I32
data types 
(4 bytes)

Not permitted

Integer 
(81 hex)

Not permitted Not permitted Not permitted Scaled value for all
parameters
represented as
integer (4 bytes)

Not permitted

Floating point 
(82 hex)

Scaled
representation for
all parameters as
floating point
(4 bytes)

Not permitted Not permitted Not permitted Not permitted

Tab. 20: Attribute, format: Possible combinations
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11.4 Process data modules
Process data modules determine the data volume for the PZD transmission. During configuration in TIA Portal, one of the
following process data modules must be configured for each axis of the drive controller. When creating a new project, we
recommend the all consistent transfer type.

Module Input data [byte] Output data [byte] Transfer

M101 02W PZD
all cons.

4 4 2 words (inputs, outputs),
all consistent*

M102 04W PZD
all cons.

8 8 4 words (inputs, outputs),
all consistent

M103 06W PZD
all cons.

12 12 6 words (inputs, outputs),
all consistent

M104 12W PZD
all cons.

24 24 12 words (inputs, outputs),
all consistent

M105 18W PZD
all cons.

36 36 18 words (inputs, outputs),
all consistent

M106 24W PZD
all cons.

48 48 24 words (inputs, outputs),
all consistent

M107 36W PZD
all cons.

72 72 36 words (inputs, outputs),
all consistent

M111 02W PZD
Item cons.

4 4 2 words (inputs, outputs),
Items consistent**

M112 04W PZD
Item cons.

8 8 4 words (inputs, outputs),
Items consistent

M113 06W PZD
Item cons.

12 12 6 words (inputs, outputs),
Items consistent

M114 12W PZD
Item cons.

24 24 12 words (inputs, outputs),
Items consistent

M115 18W PZD
Item cons.

36 36 18 words (inputs, outputs),
Items consistent

M116 24W PZD
Item cons.

48 48 24 words (inputs, outputs),
Items consistent

M117 36W PZD
Item cons.

72 72 36 words (inputs, outputs),
Items consistent

Tab. 21: Process data modules

*) all consistent: Process data packet is processed once the packet has been fully received

**) Items consistent: Individual parameters of the packet are processed once the parameter has been fully
received
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11.5 Detailed information
The documentation listed in the following table offers additional relevant information about the associated drive
controllers.

Current document versions can be found at http://www.stoeber.de/en/downloads/.

Device/Software Documentation Contents ID

SD6 drive controller Manual System design, technical data,
project configuration, storage,
installation, connection,
commissioning, operation, service,
diagnostics

442426

Drive Based (DB) application Manual Project planning, configuration,
parameterization, function test,
detailed information

442706

Additional information and sources that form the basis of this documentation or are referenced by the documentation:

Information concerning PROFINET

You can find general information on PROFINET on the PROFIBUS & PROFINET International (PI) website at http://
www.profibus.com. PROFINET-specific guidelines, profiles, presentations, brochures and software are available in the 
corresponding download area.

Information concerning the Siemens TIA Portal

The most important information about the Siemens TIA Portal and additional documents, links and training courses can be 
found at 
http://www.industry.siemens.com/topics/global/en/tia-portal/pages/default.aspx.

SD6 – Device description

A GSD file for easily integrating the drive controllers of the SD6 series into the respective system environment can be found 
in the STOBER download center http://www.stoeber.de/en/downloads/ using the search term GSD.

STOBER TIA Portal example projects – Programming acyclical communication services

STOBER-specific example projects along with the accompanying documentation for programming acyclical communication 
services in TIA Portal can be found in the STOBER download center http://www.stoeber.de/en/downloads/ using the search
term TIA Portal.

http://www.stoeber.de/en/downloads/
http://www.profibus.com
http://www.profibus.com
http://www.industry.siemens.com/topics/global/en/tia-portal/pages/default.aspx
http://www.stoeber.de/en/downloads/
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11.6 Abbreviations

Abbreviation Meaning

BF Busfehler (en: Bus error)

CBA Component Based Automation

CPU Central Processing Unit

DCP Discovery and Configuration Protocol

DHCP Dynamic Host Configuration Protocol

DP Decentral peripherals

EMC Electromagnetic Compatibility

GSD General Station Description data

GSDML General Station Description Markup Language

HMI Human Machine Interface

HTTP Hypertext Transfer Protocol

IEC International Electrotechnical Commission

IEEE Institute of Electrical and Electronics Engineers

I/O Input/Output

IP Internet Protocol

IRT Isochronous Real-Time

LAN Local Area Network

LSB Least Significant Bit

MAC Media Access Control

PG Programmiergerät (en: Programming device)

PROFIBUS Process Field Bus

PROFINET Process Field Network

PZD Process Data

RDREC Read Record

RT Real-Time

RxPZD Receive PZD (receive process data)

SNMP Simple Network Management Protocol

PLC Programmable Logic Controller

TIA Totally Integrated Automation

TCP Transmission Control Protocol

TxPZD Transmit PZD (transmit process data)

UDP User Data Protocol

WRREC Write Record
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12 Contact

12.1 Consultation, service and address
We would be happy to help you!

We offer a wealth of information and services to go with our products on our website:
http://www.stoeber.de/en/service

For additional or personalized information, contact our consultation and support service:
http://www.stoeber.de/en/support

Do you need our first-level support?: 
Phone +49 7231 582-3060 
applications@stoeber.de

Do you need a replacement device?:
Phone +49 7231 582-1128
replace@stoeber.de

Call our 24-hour service hotline:
Phone +49 7231 582-3000

Our address: 
STÖBER Antriebstechnik GmbH + Co. KG
Kieselbronner Strasse 12 
75177 Pforzheim, Germany

12.2 Your opinion is important to us
We created this documentation to the best of our knowledge with the goal of helping you build and expand your expertise
productively and efficiently with our products.

Your suggestions, opinions, wishes and constructive criticism help us to ensure and further develop the quality of our
documentation.
If you want to contact us for a specific reason, we would be happy to receive an e-mail from you at:
documentation@stoeber.de

Thank you for your interest.
Your STOBER editorial team

http://www.stoeber.de/en/service
http://www.stoeber.de/en/support
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12.3 Close to customers around the world
We offer you committed, expert advise and support in over 40 countries worldwide:

STOBER AUSTRIA
www.stoeber.at
Phone +43 7613 7600-0
sales@stoeber.at

STOBER SOUTH EAST ASIA
www.stober.sg
sales@stober.sg

STOBER CHINA 
www.stoeber.cn 
Phone +86 512 5320 8850
sales@stoeber.cn

STOBER SWITZERLAND 
www.stoeber.ch 
Phone +41 56 496 96 50 
sales@stoeber.ch

STOBER FRANCE 
www.stober.fr 
Phone +33 4 78.98.91.80 
sales@stober.fr

STOBER TAIWAN 
www.stober.tw 
Phone +886 4 2358 6089 
sales@stober.tw

STOBER ITALY 
www.stober.it 
Phone +39 02 93909570 
sales@stober.it

STOBER TURKEY 
www.stober.com 
Phone +90 216 510 2290 
sales-turkey@stober.com

STOBER JAPAN 
www.stober.co.jp 
Phone +81 3 5875 7583
sales@stober.co.jp

STOBER UNITED KINGDOM 
www.stober.co.uk 
Phone +44 1543 458 858 
sales@stober.co.uk

STOBER USA 
www.stober.com 
Phone +1 606 759 5090 
sales@stober.com
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Glossary

100Base-TX

Ethernet network standard based on symmetrical copper cables in which the nodes are connected to a switch via
copper cables twisted in pairs (shielded twisted pair, CAT 5e quality level). 100Base-TX is the subsequent progression
from 10Base-T and includes those properties with the option of a transfer speed of 100 Mbps (Fast Ethernet).

Broadcast domain

Logical grouping of network devices within a local network that reaches all nodes via broadcast.

GSD file

Includes the technical features of a PROFINET IO device (type, configuration data, parameters, diagnostic information,
etc.) in XML format in accordance with the GSDML specification. A GSD file serves as the configuration basis for project
configuration systems and is generally provided by the respective device manufacturer.

IO controller

Generally, a programmable logic controller that controls automation tasks and regulates data communication.

IO device

A decentralized field device that is assigned logically to a PROFINET IO controller that manages and controls it. 
An IO device consists of multiple modules and submodules.

IO supervisor

Generally, engineering software that can access all process and configuration data. An IO supervisor is only engaged
temporarily for parameterizing the IO devices, commissioning the IO system and for diagnostic purposes.

IPv4 limited broadcast

Type of broadcast in a network with IPv4 (Internet Protocol version 4). The IP address 255.255.255.255 is entered as
the destination. The content of the broadcast is not forwarded by a router, which limits it to the local network.

MAC address

Also: Ethernet address. Hardware address for unique identification of a device in an Ethernet network. 
The MAC address is assigned by the manufacturer and consists of a 3-byte manufacturer ID and 3-byte device ID.

PROFINET

Open Ethernet standard of PROFIBUS Nutzerorganisation e. V. (PNO) for automation.

PZD

Control and status information that is time-critical and transmitted in the PROFINET network cyclically using telegrams.
Depending on the view of the respective node, a distinction is made between receive PZD (RxPZD) and transmit PZD
(TxPZD).
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RxPZD

Output data that a node receives with RxPZDs.

System function block (Siemens)

Code block as part of a distributed, structured Siemens user program used to call up important system functions for
PROFINET IO. Parameters for the associated input and output interfaces can be configured individually. The variable
values stored in a function block are saved and are not lost after processing. Typical Siemens system function blocks
are WRREC (Write record) and RDREC (Read record).

TCP/IP

Protocol family composed of the transmission control protocol (TCP) and the Internet protocol (IP). TCP is responsible
for transmission, i.e. actual data traffic; IP handles unique communication with a PC in a network.

TxPZD

Input data that a node transmits with TxPZDs.

UDP/IP

Minimalist transport protocol for networks such as LAN that only provides the essential functions for data transport.
UDP/IP is a simple service that functions without a continuous connection on both sides. There is no connection or
disconnection and no acknowledgment of the received data packets. There is the option to control data traffic using a
checksum. As with TCP/IP, there are no troubleshooting mechanisms. Therefore, it is entirely possible for the
transferred data to experience data loss, data duplication or sequence errors.
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